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Museum Madness

Succumb to Museum Madness!
Enter at your own risk! Something has gone terribly wrong. All 
of the exhibits are quite literally out of order. Dinosaur bones 
have been scrambled . . . a woolly mammoth is wandering the 
hallways . . . the Wright Brothers can’t remember how to build 
an airplane. You must restore order. The museum’s roaming 
robot, MICK (short for Museum Information Computer Kiosk), 
will lend a hand, but mostly you’re on your own. The museum 
contains five halls: Technology, Air and Space, American 
History, Natural History, and World History. Each hall 
contains five exhibits. To discover why things went haywire, 
you’ll have to restore order to all 25 exhibits.

A successful visit depends strongly on an ability to read 
information and make decisions based on that information. 
This requires reading skills at the fifth-grade level or above. 
Children who do not read at this level can still enjoy playing 
the Museum Madness™ software program with the assistance 
of an accomplished reader.

Installation
1. Insert the CD-ROM into your CD-ROM drive. A new 

window appears, displaying an icon called Installer.

2. Double-click on the Installer icon.

3. Make sure that the hard disk indicated is the one on which 
you want to install the program. If it is not the right one, 
click on the “Switch Disk” button until you see the name of 
the disk you want.

4. Click on the “Install” button and follow the on-screen 
instructions.

5. When you see the message “Installation Successful,” click 
on the “Quit” button. Store your disks in a safe place as a 
backup copy of the program.
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Start-up
Double-click on the Museum Madness icon.

The very first time you play, the program begins with a scene 
that explains what has gone wrong at the museum. Then you 
have a series of problems to solve:

• When you arrive at the museum, it’s closed for repairs! 
You must figure out how to get in.

• Okay—you’re inside the museum, but you’re stuck in the 
maze-like basement. How can you get to the lobby?

• When you make your way to the lobby, your sources of 
help—MICK the robot and the museum’s map—are out 
of order. You must set things right before you can start 
visiting the exhibits.

At any point in this process, you can press the Esc key to go 
directly to the next scene.

When you have put together the museum’s map, it would be a 
good idea to save your game (see “Saving a Game” on page 5). 
The next time you play Museum Madness, you can start at the 
very beginning, or you can load your saved game to go directly 
to the museum exhibits.

How to Play
Museum Madness is a game that makes you think. You need to 
listen to what people say. You need to read signs. And you 
need to explore the exhibits to find things that will help you. If 
you get stuck, MICK might be able to help.
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Moving Around
When the pointer looks like a sneaker, you can move around in 
the immediate area.

When the pointer looks like an arrow, you can move from one 
room or area to another.

Inspecting Things
When you point at an important part of an exhibit, the pointer 
looks like a magnifying glass. Click on the item. You get a 
close-up view, and you usually begin a new activity.
When you are done inspecting something, move the pointer to 
the outside of the screen. The pointer will turn into the word 
“Close.” Click the mouse button to return to your previous 
activity.

Reading About Things
All exhibits have a little box at the bottom left corner. When 
you point to it, the pointer looks like the letter “i”—for 
information. Click on the box to learn more about the exhibit. 
When you’re done reading, click the mouse button or press the 
Return key.

Talking to People
You can talk to most everyone you see in the exhibits. Point to a 
person; the pointer will look like a text balloon. When you’re 
done reading, click the mouse button or press the Return key.
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Talking to MICK
When you point at MICK, the pointer looks like a question 
mark. Click on MICK. He may be able to give you some useful 
advice.

Picking Things Up
When you point at a useful item, the pointer looks like a hand. 
Click on the item to pick it up; it goes into E. J.’s backpack. 

Using Items in the Backpack
After you arrive at the museum, you can get into E. J.’s 
backpack. It contains many useful items. Sometimes, you need 
to find an item, put it in the backpack, and use it later. Other 
times, you can use an item that E. J. already has in his 
backpack.

Getting into the Backpack
Point to the backpack and click, or move the pointer to the top 
of the screen. When you point to an object, its name appears at 
the bottom of the display.

Using an Item
1. Open the backpack.

2. Click on the item that you want to use; the pointer will look 
like that item.

3. Point to the object or person that you think can use the item 
and click again.

If you have figured out the proper use for the item, 
something will happen. If not, nothing will happen; click on 
E. J. to put the item away.
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Using Menu Commands and the Game Disk
For several operations, there are two ways to accomplish the 
same thing: You can use commands on the menu bar, or you 
can use the Game disk in E. J.’s backpack. (E. J.’s disk becomes 
the Game disk after you solve a couple of problems in the 
museum’s lobby.)

Displaying the Menu Bar and Changing the Game Window
When you start Museum Madness, the menu bar is not 
displayed. To see it, move the pointer to the top of the screen. 
You can use the Show Background command on the Options 
menu to keep the menu bar visible.

The Options menu also has three commands that let you 
change the size of the game window.

Saving a Game
You can save a game only when you are in the museum lobby.

You can use the Save command on the File menu (which works 
just like the Save command in other Macintosh programs), or 
you can use the Game disk in E. J.’s backpack. Here’s how to 
use the Game disk:

1. Open the backpack.

2. Double-click on the Game disk.

3. Click on the Disk Options button, and then click on the 
Save button.

4. Type a name and press the Return key.

Opening a Saved Game
You can use the Open command on the File menu (which 
works just like the Open command in other Macintosh 
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programs), or you can use the Game disk in E. J.’s backpack. 
Here’s how to use the Game disk:

1. If you are just starting the program (and you have saved a 
game before), click on the Load button.

If you are in the middle of a game, click on the backpack 
and then double-click on the “Game” disk. Save your 
current game if you like, and then click on the Load button.

2. Click on the name of the game that you want to load, and 
then click on the Load button or press the Return key.
You may need to click on the Up- and Down-Arrow keys to 
see a complete list of your saved games.

Turning Sound Off and On
There are enjoyable sound effects and music throughout the 
program. You can turn them off and on by using commands on 
the Options menu, or you can use the Game disk in E. J.’s 
backpack. Here’s how to use the Game disk:

1. Open the backpack.

2. Double-click on the Game disk.

3. Click on the Sound Options button.

4. Click on the Music and Effects buttons to turn them off and 
on. When you’re done, click on the OK button.

Quitting
You can use the Quit command on the File menu, or you can 
use the Game disk in E. J.’s backpack. Here’s how to use the 
Game disk:

1. Open the backpack.

2. Double-click on the Game disk.

3. Click on the Disk Options button, and then click on the Exit 
button.

4. Click on the Yes button.
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What’s in the Museum?
Here are brief descriptions of what you can expect to find in 
each of the exhibits.

Exhibit Description

 Hall of Technology

Robots Track down a malfunctioning robot who has 
run amok, dismantle it, and use the parts to 
fix the other robots in the exhibit.

Computer Technology The museum’s computer can’t tell the 
difference between a 1 and a 0. Bit by bit, 
you need to help the computer regain its 
memory.

Discovery of Radio Marconi and other inventors need help with 
their experiments that lead to the discovery 
of radio.

Energy Technology Energy power plants are polluting the entire 
museum! Help make them work cleanly.

Simple Machines An escaped kangaroo has made a shambles 
of the exhibit! Fix the pulleys, levers, and 
ramps, and use them to capture the 
kangaroo.
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 Hall of Air and Space

How Big Is the Universe? The earth and moon . . . the solar system . . . 
the entire galaxy is out of order! Can you put 
it back together?

Planetarium The planetarium’s projection system is out 
of whack. It’s up to you to make the stars 
appear in their correct positions.

Rockets and Computers Rockets depend on computers. But the 
computers have lost their memory! You 
need to reprogram the computers.

Air-Powered Flight The museum’s air-circulation system has 
blown all the hot-air balloons, kites, and 
gliders into disarray. Fix the fan and put 
everything back where it belongs.

The Wright Brothers The Wright Brothers can’t remember how to 
fly. If you can’t help, everyone will have to 
fly the friendly skies on bicycles.

 Hall of American History

Transcontinental Railroad Go to work for the railroad and piece 
together the correct route for America’s first 
cross-country railroad.

Salem Witch Trials Salem’s teenage girls have been accused of 
being witches! Can you find logical 
explanations for events that the town elders 
believe are caused by witchcraft?

Exhibit Description
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Revolutionary War George Washington can’t remember who are 
his allies and who are his enemies. Help 
George separate friend from foe.

Ellis Island Experience the trials and tribulations of 
America’s immigrants in the late nineteenth 
century. Your reward: U. S. citizenship.

Louisiana Purchase Help Thomas Jefferson obtain the 
information he needs to acquire most of the 
western United States from Napoleon.

 Hall of Natural History

Dinosaurs The dinosaur bones are all jumbled. Use the 
dino-computer to put them back together.

Ocean Life The museum’s ocean tank is polluted. What 
is the source of the pollution, and how can 
you stop it?

Animal Habitats The animals have escaped from the desert, 
wetland, forest, and jungle. Your job is to put 
the animals back into their proper homes.

Ecology The ecosystem displays are out of balance. 
You must sort things out and restore order 
to the natural world.

Geology The world’s continents have drifted apart. 
Can you put the world back together the 
way it was 180 million years ago?

Exhibit Description
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A Little Hint
We’re not going to tell you how to fix any of the exhibits, but 
we will help you get into the museum lobby.
If you find yourself stuck outside the museum or in the 
basement, and you just can’t figure out what to do, there is a 
shortcut: Press the Esc key.

 Hall of World History

Prehistoric People The woolly mammoth has escaped! The 
Neanderthals are panicking! Help!

Development of Writing Help a young student from ancient Egypt 
with her homework.

Knights, Heraldry, and 
Jousting

The King’s knight has taken over his exhibit. 
Put him in his place by beating him in a 
jousting contest.

Galileo’s Telescope The matter of gravity has drawn Galileo 
away from his main mission: inventing the 
telescope. Help him regain his focus.

Industrial Revolution The machines that will spur the Industrial 
Revolution are broken. Unless you can fix 
them, the television will never be invented.

Exhibit Description
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MECC Guarantee
We stand behind our products. Try any 
MECC software for 30 days. If it fails to live 
up to your expectations, return it to us in its 
original condition, with proof of purchase, 
and we’ll give you a full refund. For a period 
of 90 days after your purchase, MECC will 
replace free of charge any defective original 
disk, upon receipt of the disk and with proof 
of purchase. After 90 days, MECC will 
replace defective disks for a nominal fee 
throughout the lifetime of the product (i.e., 
for a period of three years following the 
product’s discontinuation).

MECC Software License Information
You should carefully read the terms and con-
ditions of this agreement before using this 
package. Use of any portion of the package 
indicates your agreement to these terms and 
conditions. If you do not agree to these terms, 
return the unopened disk envelope along 
with the rest of the package to your place of 
purchase.

Permitted Uses
You may:

• operate the software on one computer at 
a time;

• make one backup copy of the software 
for archival purposes only;

• transfer the software to a single hard 
disk or other storage device and keep the 
original disks as your archival copies;

• transfer the software and all rights under 
this license to another person together 
with a copy of this agreement, provided 
you send MECC written notice and the 
other party reads and accepts this agree-
ment;

• install this software on a file server and 
execute the software on a network on 
more than one computer, provided that 
the total number of computers simulta-
neously using the software does not 

• exceed the number of copies of the soft-
ware purchased. For example, if you 
purchased five copies of this package, 
you may have up to five users simulta-
neously running the package even 
though only one copy of the software is 
installed on the network’s file server.

Prohibited Uses
You may not:

• modify the software except as permitted 
in the normal use of the product;

• reverse-engineer, disassemble, decom-
pile, or make any attempt to discover the 
source code of the software;

• translate or create derivative works 
based on the software;

• remove, obscure, or alter any notice of 
the MECC software copyright or other 
proprietary rights related to the package;

• sub-license, sell, lend, rent, or lease any 
portion of the software;

• copy any portion of the software except 
as permitted for archival purposes or 
transfer to another medium;

• transfer the software or any direct product 
to any person or entity in violation of the 
United States Export Administration Act.

Limited Warranty
MECC warrants that the accompanying disks 
will operate on the specified, appropriately 
configured Macintosh computers.
EXCEPT AS SPECIFICALLY SET FORTH 
ABOVE, MECC DISCLAIMS ALL OTHER 
WARRANTIES, EITHER EXPRESSED OR 
IMPLIED, INCLUDING BUT NOT LIMITED 
TO IMPLIED WARRANTIES OF MER-
CHANTABILITY OR FITNESS FOR A PAR-
TICULAR PURPOSE. THIS LIMITED 
WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS, AND YOU MAY ALSO HAVE 
OTHER RIGHTS, WHICH VARY FROM 
STATE TO STATE.  Except as specifically set 
forth above, MECC and its distributors will 
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in no event be liable for any damages whatso-
ever, either direct or indirect, including but 
not limited to loss of business profits, income, 
or use of data. Some states do not allow 
exclusion or limitation of incidental or conse-
quential damages; therefore, the limitations 
set forth in this agreement may not apply to 
you.
MECC'S LICENSOR(S) MAKES NO WAR-
RANTIES, EXPRESSED OR IMPLIED, 
INCLUDING WITHOUT LIMITATION THE 
IMPLIED WARRANTIES OF MERCHANT-
ABILITY AND FITNESS FOR A PARTICU-
LAR PURPOSE, REGARDING THE  
SOFTWARE.  MECC'S LICENSOR(S) DOES 
NOT WARRANT, GUARANTEE, OR MAKE 
ANY REPRESENTATIONS REGARDING 
THE USE OF OR THE RESULT OF THE USE 
OF THE  SOFTWARE IN TERMS OF ITS 
CORRECTNESS, ACCURACY, RELIABIL-
ITY, CURRENTESS OR OTHERWISE. THE 
ENTIRE RISK AS TO THE RESULTS AND 
PERFORMANCE OF THE  SOFTWARE IS 
ASSUMED BY YOU. THE EXCLUSION OF 
IMPLIED WARRANTIES IS NOT PERMIT-
TED BY SOME JURISDICTIONS. THE 
ABOVE EXCLUSION MAY NOT APPLY TO 
YOU.
IN NO EVENT WILL MECC'S LICEN-
SOR(S), AND THEIR DIRECTORS, OFFIC-
ERS, EMPLOYEES OR AGENTS 
(COLLECTIVELY MECC’S LICENSOR) BE 
LIABLE TO YOU FOR ANY CONSEQUEN-
TIAL, INCIDENTAL OR INDIRECT DAM-
AGES (INCLUDING DAMAGES FOR LOSS 
OF BUSINESS PROFITS, BUSINESS INTER-
RUPTION, LOSS OF BUSINESS INFORMA-
TION, AND THE LIKE) ARISING FROM 
THE USE OF OR THE INABILITY TO USE 
THE SOFTWARE EVEN IF MECC'S LICEN-
SOR HAS BEEN ADVISED OF THE POSSI-
BILITY OF SUCH DAMAGES. BECAUSE 
SOME JURISDICTIONS DO NOT ALLOW 
THE EXCLUSION OR LIMITATION OF LIA-
BILITY FOR CONSEQUENTIAL OR 

INCIDENTAL DAMAGES, THE ABOVE 
LIMITATIONS MAY NOT APPLY TO YOU.
MECC's Licensor’s liability to you for actual 
damages from any cause whatsoever, and 
regardless of the form of the action (whether 
in contract, tort [including negligence], prod-
uct liability, or otherwise), will be limited to 
$50.

Government End Users
If this software is acquired by or on behalf of 
a unit of the United States Government, this 
provision applies: The software (a) was 
developed at private expense, is existing 
computer software, and was not developed 
with government funds; (b) is a trade secret 
of MECC for all purposes of the Freedom of 
Information Act; (c) is “restricted computer 
software” submitted with restricted rights in 
accordance with subparagraphs (a) through 
(d) of the Commercial Computer Software-
Restricted Rights clause at 52.227-19 and its 
successors; (d) in all respects is proprietary 
data belonging solely to MECC; (e) is unpub-
lished and all rights are reserved under copy-
right laws of the United States. For units of 
the Department of Defense (“DoD”), this 
software is licensed with “Restricted Rights” 
as that term is defined in the DoD Supple-
ment to the Federal Acquisition Regulation 
52.227-7013 (c) (1) (ii), Rights and Technical 
Data and Computer Software and its succes-
sors, and: Use, duplication, or disclosure is 
subject to restrictions as set forth in subdivi-
sion (c) (1) (ii) of the Rights in Technical Data 
and Computer Software clause at 52.227-
7013. MECC, 6160 Summit Drive North, Min-
neapolis, Minnesota 55430-4003. If this soft-
ware was acquired under GSA schedule, the 
U.S. Government has agreed to refrain from 
changing or removing any insignia or letter-
ing from the software or the documentation 
that is provided or from producing copies of 
the manuals or media (except for backup 
purposes and in accordance with the terms of 
this Agreement).
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